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By installing or using the PixelToolbox software you consent to be
bound by this agreement. If you do not agree to all of the terms of
this agreement, you must not install or use the software.

The software is provided as is without warranty of any kind. The
entire risk as to the quality and performance of the software is
borne by you. No use of the software is authorized except under
this disclaimer. AxiomX will not be held liable for any damages
whatsoever arising from the use of the software.

The software is protected by copyright and other intellectual prop-
erty laws and by international treaties.

Legal Information

Commercial Distribution Prohibited Without Premission
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System Requirements

Minimum requirements:

• Intel Pentium II 200-MHz processor
• Windows 95/98/ME/2000/XP/NT 4 or later
• 32MB of available RAM
• 20MB of available disk space
• Color monitor running at 16-bit or higher
• Mouse or Drawing Tablet

Recommended:

• Intel Pentium III 500-MHz processor
• Windows 95/98/ME/2000/XP/NT 4 or later
• 128MB of available RAM
• 20MB of available disk space
• Color monitor running at 24-bit
• Drawing Tablet
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Installation

To install PixelToolbox on a Windows computer:

1. Unzip ‘PixelToolbox.zip’ to a temporary folder
2. Run Setup.exe
3. Follow the on-screen instructions
4. Launch PixelToolbox by selecting it from the Start Menu

To uninstall, run the uninstall program via the Start Menu or the
Add/Remove Programs Control Panel applet.
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Introducing PixelToolbox

PixelToolbox is the complete solution for designing desktop graph-
ics for the Windows operating system. Create, edit, and apply 1-bit
patterns, wallpaper tiles, icons, and cursors - all from a single
integrated environment.

PixelToolbox offers the standard set of painting tools along with a
few filters and features not found in other software. The unique
interface, tools, and workflow were engineered to maximize your
creative potential.

The user interface is a virtual ‘drawing desktop’ with everything you
need close at hand. The tools are arranged for quick and intuitive
access, and designed to be elegant and non-obtrusive.

This software was designed for artists by an artist with years of
experience in fine art, digital design, and user interface design.
We hope that our hard work becomes a creative experience that
will please your muse countless times.

Enjoy!
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New Screen

The New Screen is where you select the project, size, and color
space to work in. This is the screen that appears immediately after
launching PixelToolbox, and is always accessible by clicking on the
New button that is common to every project space.
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New Screen

There are 4 projects to choose from:

• 1-bit Pattern - 8x8 pixel, black & white patterns saved in a
special integer format to a file called ‘Control.ini’. Although
limited, this format is very space efficient.

• Color Pattern - Also known as Wallpaper tiles, these designs can
be created in virtually any color depth and can be used as
wallpaper, or exported for use in other applications.

• Windows Icon – These small graphics are the visual representa-
tion of links to programs and files.

• Windows Cursor – These small graphics serve as the onscreen
indicator of the mouse position, and current function.

There are 5 sizes available: 8x8, 16x16, 32x32, 48x48, and 64x64.

There are 4 color depths available: 1, 4, 8, and 32-bits, with 9
different palettes to choose from in 8-bit depth.

Not all color choices and sizes are available for all projects.

After making your choices, click Start to get started creating.

New Screen Options
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User Interface

The PixelToolbox window is 800x600 pixels and cannot be resized.
It can however be moved, minimized, and closed just like any
standard Windows application. To move, click and drag on any of
the window’s edges. The minimize and exit buttons are located in
the upper-right corner of the window, below the help button.

PixelToolbox Window
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User Interface

Drawing Area & Grid Overlay

In PixelToolbox all drawing takes place
inside the area located at the center of
the workspace. The drawing area is
always magnified in order to compen-
sate for the relatively small graphics
that the file formats require. The magni-
fied environment makes the act of
drawing feel more natural, and also
makes editing individual pixels a snap.

The interactive grid overlay is a handy guide that divides the
workspace into pixel-sized units, or converts into a perspective grid
for creating Windows XP-style icons. To control the grid overlay:

Click this button to toggle the grid’s visibility.

Toggles the grid color between gray and the reverse of the
color beneath.

Toggles the grid between pixel mode and perspective mode.
This option is only available in the icon project space.
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User Interface

File Menu

Located in the upper-left corner of the work-
space, the File menu provides you with the
functions you need to manage your file output.

New - Exit the current project and return to the ‘New’ screen.

Import - Import an image into the current project. Images are
imported as active selections so they can be repositioned. If the
imported image is larger than the project, it is scaled to fit within
the bounds of the project while maintaining its original proportions.
With selections, the imported image is scaled to fit the selection.

Revert - Returns saved projects to the last saved state.

Save As - Invokes a dialog box that allows you to name and save
your project.

Save - Automatically saves changes to projects saved in the same
session using Save As.

Undo/Redo - Toggle virtually any change you make to your project.
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User Interface

Current Menu

The Current menu contains an actual-size
preview of the current project, along with the
clipboard functions. As with most of the actual-
size previews in PixelToolbox, the Current pre-
view can be magnified to 64x64 pixels in

projects that are 32x32 pixels or smaller. The Current menu also
shares the Swap function with the Snapshots menu.

Copy the entire image or a selection to the clipboard.

Paste the contents of the clipboard into the current project
as an active selection. If the pasted image is larger than
the current project, it is scaled to fit within the bounds of
the project while maintaining its original proportions. With
selections, the pasted image is scaled to fit the selection.

Swap the current image and the selected snapshot in one
operation. Handy when all the snapshots are in use.

The Snapshots menu is described on the following page.
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User Interface

Snapshots Menu

Snapshots are versions of your project that you
can record and go back to at any time. Snap-
shots extend the standard Undo function by
allowing you to temporarily save, view, and
select from multiple versions of your project.

There are 4 snapshot placeholders in every workspace, more than
enough to free you from the burden of mistakes, and encourage
you to explore new possibilities.

To select a snapshot, simply click on it. Snapshots can be magni-
fied if they are selected.

Take a snapshot of the current image.

Apply the selected snapshot to the current image.

Swap the current image and the selected snapshot in one
operation. Handy when all the snapshots are in use.

To Clear a snapshot, double right click on it.
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User Interface

Tiling Preview Menu

The Tiling Preview Menu consists of a real-time
preview of your tiled design, along with func-
tions to apply the design to your desktop, and
export it to a variety of formats. The tiling
preview area updates automatically as you
paint and manipulate your images, giving you
indispensible feedback that makes creating
accurate tiles easy and fun.

Apply - Saves changes to the current project and applies the
design to the desktop in one operation. If the current project
has not been saved, you will be prompted to save it. Applies
as a pattern in 1-bit, and as wallpaper in the color spaces.

Export - Exports the current project to a variety of formats
including Web-ready JPG, and PNG formats.

Control Panel Applets - Opens the Windows Display, or
mouse control panel depending on the project. The tiling
preview, and the apply to desktop and export functions are
replaced in cursor and icon projects with the applet control.
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User Interface

1-bit Pattern Browser

1-bit patterns are 8x8 pixel, black & white patterns
saved as a series of 8 integers to a file named
‘Control.ini’. Although limited in possibilities, this
format is very space efficient. On average each
pattern occupies a whopping 30 bytes on your hard
drive. Windows does come with a basic browser/
editor for 1-bit patterns, but if you’ve ever used it
you’ll agree that it’s a very limited and uninspiring
workspace. In PixelToolbox, the Pattern Browser is
integrated into the 1-bit Pattern work space for
easy access. Edit, rename, and delete patterns on
the fly, in an environment designed to inspire you.

To preview a pattern in the preview window, select it from the list.

To rename the selected pattern, double click on the Current Pattern
Field located directly below the list.

Edit - Loads the selected pattern into the workspace for editing.

Delete - Deletes the selected pattern from your collection.
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User Interface

Status Displays

The status displays are text displays that provide you with valuable
information such as cursor position, color values, and tool tips,
giving you the feedback that you need to work with precision.
The primary status displays are grouped together and centered at
the bottom of the PixelToolbox workspace.

File Status - After using ‘Save As’, the name of the file is written to
this status display.

Tips Status - All tool tips and keyboard shortcuts appear here.
Shift+click to toggle the visibility.

Coordinates Status - Shows mouse position inside the drawing
area, and the width and height of selections, shapes, and gradients.

Color Status - Works with palettes, color chips,
the RGB Picker, and the Color Dropper to show

you the RGB, hexadecimal, and palette index values of a color.
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Foreground & Background Color Chips

User Interface

The foreground and background color chips are an inte-
gral part of every project space. All of the drawing tools
work with one, or both of these colors depending on the
tool. Although the palettes vary between the project
spaces, the color chips function basically the same way.

The foreground color always defaults to black, and the background
color to white. You can return a chip to its default value when it’s
selected by double right clicking the chip.

To change the color of one of the chips, select the chip by clicking
on it, then choose a color from the current palette.

To swap colors between the chips, click on the semi-circular arrow
to the left of the chips.

The foreground and background chips behave a little differently in
the 1-bit pattern space, since there are no other colors to choose
from. In the 1-bit space, clicking either chip has the effect of swap-
ping colors between the chips. The foreground chip always remains
selected.
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User Interface

Working with Palette Colors

Palettes are indexed color sets used in digital design to produce
graphics with small file sizes that look the same on any platform.

The 4-bit palette consists of 16 colors. This palette is a
remnant from the early days of personal computing

when monitors displayed only 16 colors. It is still used to design
icons, cursors, and graphics for older systems and portable devices
with limited displays.

8-bit palettes contain 256 colors. Although used more
frequently than the 4-bit palette, 8-bit palettes are also a
remnant from an earlier time. 8-bit images are still used
a great deal in Web design, software design, and multi-
media because of their relatively small file sizes.
PixelToolbox gives you 9 beautiful 8-bit palettes to
choose from.

To select a color from the 4 & 8-bit palettes, simply click
on the color. Selecting a color changes the color of the
color chip currently selected.
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User Interface

Working with RGB Colors

RGB is the color model that modern computer monitors use to
display colors. In this model, red, green, and blue values are speci-
fied as levels ranging from 0 to 255. Amazing as it seems, with this
model it is possible to ‘mix’ just about any color that you can imag-
ine... 16, 777, 216 possible colors to be exact.

The RGB color picker consists of a slider and
text box for each of the color components. As a
rule, lower values produce darker colors, and
higher values produce lighter colors. Pure grays

are mixed with equal values of each color component.

The Custom Palette allows you to work with a
palette of your favorite colors in 32-bit mode. It
integrates with the color picker to make using
and saving custom colors as easy as possible.

When ‘Edit Colors’ is checked, clicking on a color changes the color
to the color of the selected chip. When it is unchecked, clicking the
color changes the color of the selected chip to the custom color.

Save - Writes the RGB values of the colors to ‘PixelToolbox.ini’.
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User Interface

Common Menus

PixelToolbox contains several tool menus - some are common to all
of the project spaces and color depths, while some are unique to a
particular project or color depth. In addition, a few of the common
tools function differently depending on the project or color depth.

The Tools Menu is located directly above the drawing area. It con-
tains all of the drawing and painting tools. The tools and options in
this menu vary between projects and color depths.

The Manipulation Functions are located directly below the drawing
area. These functions affect the entire image, or active selections.

The Effects Menu is located in the lower-left
corner of the workspace. Here you will find
Pattern Screen and Fast Weave - unique func-
tions to texture and transform your designs.
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User Interface

Special Menus

In PixelToolbox the color depth determines what tools are available
and how they function. Some of the functions are written specifi-
cally to take advantage of the built-in limita-
tions of indexed palettes. Functions such as
the Randomize Color, Invert Color, and Cycle Palette Colors func-
tions are common to the 4 & 8-bit color depths. Variations of two of

these tools - Generate Random Pattern, and Invert
Pattern are available in 1-bit depth.

Since palette functions are not practical with over 16 million color
choices, PixelToolbox offers a group of functions in
32-bit color depth specially designed to work with
RGB images. Adjust HSL, and Adjust Tonality allow
you to adjust image properties such hue, contrast,
and color saturation in a completely interactive

and non-destructive way. 32-bit
color also offers a group of single-
click tools - Blur, Sharpen, Negative, and Colorize.
Even though the tools vary between color depths
remember that you can take full
advantage by copying and pasting

between color depths, usually with great results.
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the Tools

Drawing & Painting Tools

There are a total of 10 variants for the drawing and painting tools.
Each tool uses the subset of these 10 variants that best mimic its
real-world counterpart. The variants come in 4 sizes (measured in
pixels): 1, 3, 5, & 7, and 3 styles: square aliased, round aliased, and
round anti-aliased. The variants can be selected by clicking on the
variants button directly below the tool.

Pencil - Uses only the aliased variants in all 4 sizes. Works
with the Foreground color chip.
Brush - Uses all of the variants except for the 1 pixel variant.
Works with the foreground color chip.
Eraser - Uses all of the variants. Works with the background
color chip.
Airbrush - Uses the foreground color chip. It works like a
spatter brush and uses only aliased variants in 1, 4, & 8-bit
color depth. In 32-bit it uses only anti-aliased variants and
produces a faded, soft-edged stroke.
Cloning Brush - Uses all of the variants. Sample the image and
‘paint’ it into another part of the same image. Right click to
select the area to sample, then paint.
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the Tools

Shape & Line Tools

The shape tools each have 3 variants:
Outline - Draw an outline of the shape using the foreground
color chip.
Filled Outline - Draws a filled shape with an outline. The
outline uses the foreground color chip, and the fill uses the
background color chip.
Solid - Draws a filled shape with no outline. The fill uses the
foreground color chip.

The line tool comes in 5 widths: 1, 2, 3, 4, & 5
pixels. The selected width is the width that the shape tools use for
the outline variants. The variants can be selected by clicking on the
variants button directly below the tool. To draw a shape simply click
and drag in any direction.

Rectangle Tool - Draw a rectangle.

Oval Tool - Draw an oval.

Rounded Rectangle Tool - Draw a rounded rectangle.

Line Tool - Draw a straight line.
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the Tools

Elastic Gradient Tool

The Elastic Gradient Tool is an innovative revision of the
standard gradient tool found in other applications. The first

thing you’ll notice is that the gradient updates dynamically as you
draw. PixelToolbox calculates the optimal color spread to size ratio
on the fly, giving you continuous feedback. The other unique thing
is the way that the tool functions in the 4 & 8-bit color spaces.
Instead of making a smooth blend between two colors like it does
in the 32-bit color spaces, it divides the area evenly using the colors
in the palette that are numerically in between the two colors. The
results can be striking enough to give you a new reason to use
indexed colors. The Elastic Gradient tool uses both the foreground
and background color chips as the start and end points in the
gradient. The available variants are:

Draws a horizontal gradient.

Draws a vertical gradient.

Draws a rectangular radial gradient.

Draws an oval radial gradient.
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the Tools

Fill, Color Dropper, & Warp Tools

The fill tools work with the foreground color chip to fill areas in your
image that are the same color as the pixel that is clicked on.

Fill Tool - Fills a contiguous area.

Checker Fill Tool - Fills every other pixel in a contiguous area.

Selective Fill Tool - Fills every pixel in the image that is the
color of the pixel that is clicked on.

The Color Dropper changes the color of the selected color chip
to a color sampled from the image. Most of the drawing and paint-
ing tools transform into the Color Dropper when right clicked.

Color Finder - Only available in the 8-bit color spaces, this tool
hilites the location on the palette of the color that is sampled.

Warp Tool - Click and drag to distort the image from the point
clicked. Use it to make subtle changes or to completely trans-
form your image.
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the Tools

Selection Tool

The Selection Tool allows you to discretely manipulate areas
of the image, as well as reposition imported elements and

text. This tool is not available in the 1-bit Pattern project space.

To select an area in your image, click and drag in any direction.

To reposition a selection, click inside of the
selection and drag in any direction. If the
selection is one that you created, as opposed
to one created by the import or paste func-
tions, dragging the selection from its original
area, or using the image manipulation func-

tions will ‘cut’ the area out by filling it with the background color.
Alternately, you can make the selection a copy by holding down the
Shift key when you drag or manipulate the selection.

To deselect a selection, click on the gray gutter just outside the
drawing area, select another tool, or Ctrl+D.

To delete a selection, press the Delete key, use Clear Image, or drag
the entire selection off of the image and let your mouse up.
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the Tools

Text Tool

The Text Tool makes it possible to add text, symbols, and
other TrueType font characters to your images. It works with

the foreground color chip to let you specify the text color.

To add text, select the text tool and click
anywhere on your image, then enter your text
in the window that pops up, and click ok. Your
text is added to the image as a selection with

a transparent background, ready for you to reposition.

Access the font list by clicking on the
current font name, or the adjacent

button. Shift + click on the font name opens the Character Map.
Font size and character spacing can be controlled with the
size and kerning controls at the right of the Text Menu. The

range depends on the dimension in pixels of the project.
The available font styles are: Bold,
Italic, and Underline. Click to toggle.

Soft - Smooth the edges of the text with anti-aliasing.
This option is available only in the 8 & 32-bit color spaces.
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the Tools

Transparency, Inverse, & Hotspot Tools

The Transparency and Inverse Color Chips can be found in
the icon and cursor project spaces, located directly to the
right of the drawing area. The colors of these two chips
represent the transparent, and inverse-color areas. Both
colors can be disabled and enabled by right clicking the
chip. Only the transparent color can be changed.

Transparency Color Chip - The top chip is the color that will be
transparent in your icon or cursor. This color is transparent in the
workspace to allow you to accurately preview the transparency.

Inverse Color Chip - When enabled, areas painted pure black will
show the inverse of the color beneath the icon or cursor. The In-
verse Color Chip is disabled by default.

Hotspot Tool - Available only in the cursor project space, this
tool is for specifying a pixel to serve as the cursor’s hotspot.

When the hotspot is not specified, the top-left pixel (0, 0) is used.

To set a hotspot, simply click the desired pixel. The hotspot blinks
when the hotspot tool is selected and inside the drawing area.
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the Functions

Image Manipulation Functions

The following functions are available in all of the project spaces.
They affect either the entire image, or the area inside a selection.

Clear Image - Fills the image or selection with the back-
ground color.

Rotate - Rotates the image or selection clockwise in 90
degree increments.

Flip - 2 functions that flip the image or selection
horizontally, or vertically.

Nudge - 4 functions that move the image
or selection in increments of 1 pixel.

In the pattern project spaces, nudging the image is non-destructive
and cycles your design as if it were tiled. In the icon and cursor
project spaces, nudging the image makes the leading pixels disap-
pear and the trailing pixels are filled with the background color.

Mirror - 4 functions that mirror one half of
the image or selection to the other.
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the Functions

Palette Color Manipulation Functions

These functions are available in all of the 4 & 8-bit color spaces:

Cycle Palette Colors - Changes every color in your image
or selection to the prior, or next color in the palette de-

pending on the direction clicked. This function wraps between the
last and first colors in the palette.

Invert Palette Colors - Changes every color in your image
or selection to the inverse color on the palette.

Randomize Palette Colors - Changes every color in your
image or selection to a new color randomly chosen from

the palette. This function was designed to preserve the total num-
ber of colors in the image.

The following functions are available in the 1-bit pattern space:

Random Pattern - Generates a random pattern.

Invert Pattern - Makes black pixels white, and white pixels
black.
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the Functions

32-bit Color Manipulation Functions

The following functions are available in the 32-bit color spaces:

Adjust HSL - Adjust the Hue, Saturation, and Light-
ness of your image interactively. Hue is repre-
sented in degrees, and Saturation and Lightness as
percentages.
Adjust Tonality - Adjust the brightness and contrast
of your image interactively. Brightness is a linear
value, and contrast a percentage.
These two applets share several functions:
Load - Loads the current image into the applet.
Apply - Applies the changes to the current image.
To reset the sliders, click on the small arrow above
the sliders. To clear the image from the applet,

double right click the applet preview image.

The following functions are also availble in 32-bit:
Blur - Blurs the image or selection.
Sharpen - Sharpens the image or selection.

Negative - Makes your image or selection a negative.
Colorize - Colors your image or selection with the foreground color.
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the Functions

Pattern Screen & Fast Weave Functions

Pattern Screen is an innovative function that
lets you to use your collection of Windows 1-bit
patterns as textures that can be selectively
applied to your image. To use: select a pattern

from the list, adjust the Blend, then click Apply. Black pixels in the
original pattern are colored the foreground color, and white pixels
are transparent. Blend is not available in the 4-bit color spaces.

Access Fast Weave by clicking on the Pattern Screen
button. Fast Weave is not available in 1-bit.

Fast Weave is for making simple ‘woven’ de-
signs. Choose the colors, and shadow colors for
the vertical strand, the horizontal strand, and
the background. Specify the width and spacing

of the horizontal and vertical strands, and the depth of the shadow
- in pixels. The range of each number is determined by the physical
dimensions of the project. To choose a new color, select the color
chip and choose a new color from the palette or RGB picker. The
background and background shadow colors can be made transpar-
ent by right clicking the color chip. When you’re ready, click Apply.
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Keyboard Shortcuts

New: Ctrl+N
Save & Save As: Ctrl+S
Import: Ctrl+I
Export: Ctrl+E
Revert: Ctrl+R
Undo & Redo: Ctrl+Z
Set Tile: Ctrl+T

Swap Fg & Bg Colors: Ctrl+G
Grid Visibility: Spacebar
Clear: Delete

Copy: Ctrl+C
Paste: Ctrl+V
Take Snapshot: Ctrl+K
Apply Snapshot: Ctrl+P
Swap Snapshot: Ctrl+W

Quit: Ctrl+Q
Minimize: Ctrl+M
Help: Ctrl+H

Control Panel Applets: Ctrl+1

Nudge Left: Left Arrow
Nudge Right: Right Arrow
Nudge Up - Up Arrow
Nudge Down - Down Arrow

Mirror R to L: Ctrl+Left Arrow
Mirror L to R: Ctrl+Right Arrow
Mirror T to B: Ctrl+Down Arrow
Mirror B to T: Ctrl+Up Arrow

Flip H - Shift+Left Arrow
Flip V - Shift+Down Arrow

Rotate - Shift+Right Arrow

Deselect - Ctrl+D

Start (New): Enter
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File Formats

The following file formats can be imported into PixelToolbox:

• Windows Bitmap - BMP
• JPEG Image - JPG
• Portable Network Graphic - PNG
• Targa Image - TGA
• Tagged Image File Format - TIF
• Windows Desktop Pattern - Integer format (Control.ini)
• Practically any raster format via the Windows Clipboard

PixelToolbox can save and export to the following formats:

• Windows Bitmap - BMP
• JPEG Image - JPG
• Portable Network Graphic - PNG
• Targa Image - TGA
• Tagged Image File Format - TIF
• Windows Icon - ICO
• Windows Cursor - CUR
• Windows Desktop Pattern - Integer format (Control.ini)
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Technical Support

AxiomX provides limited technical support through email. We do
our best to answer your questions thoroughly and in a timely man-
ner. We are also interested in your ideas concerning new features
or functions. Please send your email to AxiomX support at:

support@axiomx.com
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Edit Pattern  16
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New Screen  8
  options  9
Nudge functions  30

O
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P
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Paste  13
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Pencil  23
projects  9

R
Randomize Color  22, 31
Random Pattern  22, 31
Rectangle Tool  24
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Rounded Rectangle Tool  24
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Save  12
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Selection Tool  27
Selective Fill Tool  26
Sharpen  22, 32
size
  project sizes 8, 9
  file size  19
  brush size  23
  font size  28
Snapshots Menu  14
Soft  28
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